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Introduction
Welcome to the Acumar DataCapture™ system manual. This document will assist you 
in basic functions of the inclinometers and Acumar DataCapture™ as well as provide 
information on advanced features and technical data.

The Acumar Digital Inclinometer Suite functions using three components:  
1.	Dual digital inclinometers that store data
2.	A wireless USB computer interface 
3.	DataCapture™ Data forms that can capture and analyze stored data.

Please take some time and browse this manual, as it will help you get the most out of 
your Acumar Digital Inclinometers and the DataCapture™  Recording Forms.  
	

Installing the Hardware
First make sure you have all the necessary components

•	 Dual digital inclinometers
•	 USB IR receiver unit
•	 USB connecting cord

Then make sure that your computer meets the system requirements
•	 One (1) GHz processor or faster
•	 512MB RAM
•	 Windows XP, with Service Pack 3, or better

Installing the IR receiver is straightforward. The IR receiver uses a USB interface, so 
plug the square end of the USB cable into the back of the available USB port on your 
computer and it should automatically install without any drivers. While you can plug the 
interface unit into your computer while it is on, we recommend that you turn off your 
computer before connecting the device. When properly connected, the green LED on 
the interface unit will be on, indicating that it is ready to use.
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You may test the Interface hardware and USB cable by pressing the “Device ID” button 
located on the bottom of the Interface unit. To test, first open a text editor such as 
notepad or Microsoft Word, or an Excel blank sheet. Then press the ID button. You should 
see it display a message like: “Acumar rev 3.0 - All Rights Reserved.” This means that the 
receiver and cable are working correctly. Place the receiver in a convenient location (say 
on top of or beside your computer) within line-of-sight of where you will be sending the 
data. The comfortable range is 3 to 15 feet.

Important: Remember that before sending data, the target form must be opened 
and the starting data cell selected where the line of data is to go.

Navigation
To navigate through Acumar DataCapture™, use the controls positioned in the header.

The controls and their basic functionality:

1.	 Patient Home: This button returns you to the main patient screen.

2.	 Review Session: This button takes you to the Review page where you can sort and 
search through data previously taken.

3.	 ROM Values: This button takes you to the Range of Motion page where you can 
enter values to record.

4.	 New Patient: This button takes you to a screen allowing you to create a new patient.
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1.	 Edit Patient: This button takes you to a screen allowing you to edit an existing 
patient.

2.	 Save Patient: This button saves the current patient data to a file.

3.	 Open Patient: This button opens an existing patient data file.

4.	 Add Session: This button takes you to a screen allowing you to create a new session.

5.	 Edit Session: This button takes you to a screen allowing you to edit an existing 
session.

6.	 Delete Session: This button deletes the current session.

7.	 Regions: Use this drop down box to select the region the desired measurement is 
part of.

8.	 Subregions: After you select your Region, this drop down is populated with the 
appropriate subregions. When you select a subregion, you will be automatically 
taken to the input form.

9.	 Sessions: This drop down contains a list of all of the current patients sessions. You 
may change what session you are working in at any time, as well as add a new 
session.

Templates
Acumar DataCapture™ supports the ability to customize the names and norms of all 
regions, subregions, and movements. To do so, find Template Options in the tool bar, 
and click on Customize Template. There you will see a tree of the regions, subregions, 
and movements and the currently used names.

After making a selection in the tree, the text boxes to the right will be filled with the 
current template data. To change the data, just change the text in the text boxes. The 
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template will be updated when you make another selection or close the Customize 
Template window. 

Header Templates
Header templates are used to fill in the 
information at the top of the window. To 
open up the Customize Header dialog find 
Header Options in the tool bar and click 
Customize Header. The dialog should look 
the image at right.

Inclinometer Use
The Acumar Digital Inclinometers measure 
angles relative to gravity. When the 
companion unit is connected to the main 
unit, it reads the subtraction of the two 
angles. To begin, press START to turn on the 
units and clear the memory. If the units are 
already on, press START to turn them off 
and then again to reset the memory. You 
will want to do this before each new test 
sequence.

Some movements are most accurately measured using two inclinometers such as the 
spinal region, while other such as the upper extremities require only one, as long as all 
other confounding body movement is stabilized. To use two inclinometers, first connect 
them with the provided connecting cable.

Become familiar with the placement and functions of the various buttons on the unit as 
you will need to be comfortable with them during each examination.

Holding data
Holding data is easy with Acumar Digital Inclinometers. For each measurement, have 
the individual in the neutral position. Place the units firmly in position and press the 
ZERO button on the main unit to set the units for measuring. Then have the individual 
attempt the desired motion. 

In order for data to be stored from both the main and companion units, they must be 
connected with the connecting cable.
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Sending data
Send data only after you have stored your readings for a particular measurement. Make 
sure that your computer has Acumar DataCapture™ open to the desired form. If you 
would like to review your stored readings before sending them to the computer, press 
VIEW. This will run through each measurement, as well as the maximum, minimum, and 
average values for the data set.

The inclinometers send data using an IR (infra red) transmitter, which is located on the 
back of the unit just above the serial number label. Make sure that when sending data 
you hold the unit with the transmitter facing the IR receiver. To send data, press the 
SEND button firmly and briefly (.5-1 second). In some environments, it may take a few 
attempts for the IR receiver to accept the data. Best results are achieved sending from a 
distance of three or more feet and less than fifteen feet. When data has been received, 
the IR receiver beeps and the LED blinks.

Note: It is best to avoid pointing the IR Wireless Receiver into the direct sun or a bright 
light.

Data Format
DataCapture™ breaks the measurements into sections of regions and subregions. 
There are three regions, and each region contains a number of subregions. The regions, 
subregions, and movements are listed below.

Measurement Sections
The Spine

Cervical 	
•	 Flexion, Extension
•	 Left, Right Lateral Bending
•	 Left, Right Rotation

Thoracic			    
•	 Flexion, Extension
•	 Left, Right Lateral Bending
•	 Left, Right Rotation

Lumbar		   	
•	 Flexion, Extension
•	 Left, Right Lateral

Upper Extremities	

Shoulder		
•	 Flexion, Extension
•	 Abduction, Adduction
•	 External, Internal Rotation

Elbow			 
•	 Flexion, Extension

Wrist			 
•	 Flexion, Extension
•	 Radial, Ulnar Deviation

Lower Extremities	

Hip		
•	 Flexion, Extension
•	 Abduction, Adduction
•	 External, Internal Rotation

Knee			 
•	 Flexion, Extension

Ankle			 
•	 Flexion, Extension
•	 Inversion, Eversion

6



Model  ACU011      User Instructions

Fax: (765) 423-4111  .  www.lafayetteinstrument.com  .  info@lafayetteinstrument.com

Technical Data
Acumar DataCapture™ automatically calculates statistical information about the data 
you enter into the form. Thus it is important to understand how the data is calculated so 
you can more accurately use it for your purposes.

When the inclinometers have finished sending data to the computer, it assesses how 
many data points have been sent. When at least three data points are detected, the 
program samples the data in sets of three. Within these sets of three, the program first 
searches for the sets with all three data within ± or 10% of their mean, whichever is 
greater. It then selects the three-data set with the maximum value and highest average. 
These data will be bolded in the sheet. If no three data-sets are within such variances, 
then the three-data set with the highest maximum value and highest average otherwise 
will be selected and these data will be subsequently bolded.

Then the average, maximum, and variance values are calculated and displayed for 
the bolded data, not for the entire set. If only two data are present, then the average, 
maximum, and variance applies to both data points, and if only one data is present, then 
the maximum and average values will be the same as the data point.

7



ACUMAR DataCapture™

3700 Sagamore Parkway North  .  Lafayette, IN 47904 USA  .  Phone: (765) 423-1505

DataCapture™ Walkthrough
Welcome to the Acumar DataCapture™ walkthrough. Here you will be guided through 
the program step by step, from creating a patient file to capturing data, and then to 
reviewing the data and creating reports. 

Home
To get started, open up Acumar 
DataCapture™. You should be at the home 
screen, as shown above.

Entering a new patient
To add a new patient, you may either click 
on the New Patient button, or click File in 
the tool bar in the top left corner and click 
New Patient. A dialog will appear where 
you may input patient information. The 
Patient Name, Patient Identifier, and Date 
of Birth fields are required. When you are 
done, click ‘OK’ to continue.
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Now that you have a patient file, you 
need to add a session. Sessions have an 
identifier, a date, and optional comments. 
They are used to store the data captured 
during any particular session. To add a 
session, click the Add New Session button 
to make the New Session Dialog appear.

Enter a Session ID. The ID may be a 
number or a word or phrase. The date is 
already filled in with today’s date, but you 
can click on a field in order to change it. 
The comments field is optional. Click ‘OK’ 
to continue. The session will appear in the 
white list box with the format of “Session 
ID - Session Date: Session Comments”.

Now that you have created a new patient, 
you will want to save the file. You can save 
or load a file at any time by going to File 
in the tool bar and clicking the respective 
Save or Load option.
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Capturing Data
To record measurements, navigate to the subregion form that you wish to capture. Take 
a look at navigation for more information on navigating Acumar DataCapture™. Once 
there you should see a screen similar to the screen shot below.

To start taking measurements, make sure that the desired control is selected and that 
the cursor is in the first cell. If it is not, click any empty place in the movement you desire 
to capture and it will be placed into the first cell. The cell that is currently selected will 
be highlighted in yellow.
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1.	 This is the name of the measurement to be taken and its associated help icon.
2.	 The customize button opens up a dialog where you can modify the name of the 

measurement, the label of the main and companion inclinometers and joint angle, 
and the value to be used for the norm. From there you can also change the name of 
the parent subregion and region.

3.	 This is the area where the data is captured. The leftmost column has the labels (from 
top to bottom) of the main inclinometer unit, the companion unit, and then the 
joint angle measurements themselves (main - companion). There are 6 columns for 
six total tests, although only 3 need to be filled for a valid dataset according to the 
AMA.

4.	 Once the data is captured, the statistics are calculated and placed into this area. ‘SD’ 
stands for standard deviation; in short, the average distance from the middle of all 
the data in the dataset. ‘CV’ is coefficient of variance, or the percentage the standard 
deviation differs from the average value.

5.	 Comments can be added here. They will be displayed in other areas of the program, 
such as in the review form and in generated reports.

Note: If you are inputting the data by hand, you must hit enter after filling out all the 
textboxes in order for the data to be calculated. If using the inclinometers, it is done
automatically.

If you need a reminder for how to take a particular measurement, click on the blue ? icon 
under the name of the measurement. A window will appear with instructions on how
to take the measurement. Close the window to continue with the tests.
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Single / Dual Inclinometry
Some measurements are best taken with two inclinometers. The spine is a good example 
of this. Others, however, may only require one as long as the rest of the body is stabilized 
as not to add artifacts to the recorded data. These templates support both single and 
dual inclinometers for Upper/Lower extremity forms.

Before you send data into the Upper rand Lower extremity forms, be sure that the 
correct mode is selected. You can switch modes by clicking on the ‘Single Mode’ or ‘Dual
Mode’ radio buttons located underneath the label for each measurement. A dialog will 
appear asking if you want to use that setting for all future measurements. These options
are only relevant to the Upper and Lower Extremity forms.

Some measurements in the spine form also use only one inclinometer, but these 
movements cannot be modified (e.g. Ankylosis measurements, and straight leg raising
measurements.) Please note that sending data from the incorrect number of 
inclinometers will cause errors in your form. Please check how many inclinometers to 
use before sending.

Capturing Data
When you have selected a form for the region and subregion that you wish to measure 
and a movement is highlighted with the cursor in the yellow cell, hold your data and 
press the SEND button. Remember that some measurements use one inclinometer and 
other use two.

When sent data is received, the IR receiver will beep and the LED on the front panel 
will blink. It will then directly enter the values of the Main and Companion Units (if two 
inclinometers are used) and then the joint angle between them.

When all data is entered, statistical tests are run on the joint angle (A-B) readings. The 
three readings which have the highest value and consistency are bolded and then the 
maximum, average, standard deviation, coefficient of variance, and percentage from 
the norm are calculated and displayed.
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Reviewing Data
Once you have completed capturing any data that you need, click the Review in the 
upper middle of the window. It will take you directly to the Review form, where you can
search through any data collected. It should look similar to the image below.

Here is a short list of what is in the window, more detailed information will be given later.

1.	 The list of all sessions for the current patient. Selecting one or more sessions will fill 
the table to the right (#5).

2.	 This is an expandable tree that is used to filter the table to display only the type of 
object that is selected.

3.	 These are the search options, used to look for specific pieces of data from the 
sessions selected.

4.	 Each graph retrieves data from the current table and organizes it to display in the 
appropriate fashion.

5.	 This is the main table. Here is where any measurements from the selected sessions 
will be displayed. When you use the search or filter, the table will display the results 
of the search or filtering.

Selecting Data
In order to filter or search for the data you want, you must select the session(s) that 
you want to search through. The sessions are listed in reverse chronological order (most 
recent to oldest) in the list. When you make a selection, the table will populate with all 
the movements from the selected session(s). Movements that do not have any captured 
data are not displayed in the table, and will not be placed in any graphs or reports.
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To simply filter the data, expand the tree until you get to the item you want e.g. the 
Cervical subregion. When you make a selection in the tree, the data will filter out 
everything that is not within the region or subregion, or is not called the same movement 
as what is selected.

You search through the data using the search options. Using the Search drop down 
box, you can select just what you want to look for. You can search for a name using 
All Names, Region, Subregion, and Movement, or you can look for a value using Max, 
Average, Norm etc. If you select an option that requires a numerical value, then two new
options will appear in the Is search box below: Greater Than and Less Than. These allow 
you to search for a value greater than or less than your search.

Below the Is drop down are the two Search Style radio buttons, Narrow Search and 
Replace. If Narrow Search is selected, when you run the search it will only search through
the items currently displayed in the table. If you replace is selected, it will search through 
every item in the currently selected session(s) and place everything into the table.

The table itself has a number of columns, most of them self explanatory. The only two 
that aren’t related directly to the movements themselves are the Date and ID columns.
These refer to the sessions that the movements were taken in.

Graph Tabs
There are 3 tabs in addition the main Review Tab: Summary Graph, Range of Motion 
Graph, and History Graph. The Summary and Range of Motion graphs are session graphs; 
they only use data from a single session. If you have multiple sessions selected, you will 
be asked to pick a single session to use. If you have multiple sessions selected, you will 
be asked to choose a single session to use for the graph. The history graph, on the other 
hand, requires data from two or more sessions. It is used to graph the measurement of 
movements over and extended period of time. The data that is selected for the graph 
differs from the History graph and the session graphs. The session graphs always takes 
in all data from a single session that you select, due to the way the data is organized. The 
history graph, however, uses only the data that has been searched for and is currently 
being displayed within the Review Tab’s table.
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Summary Graph

The summary graph graphs movements based on the subregion it is contained in. In the 
top left is the Range of Motion list, where you can select which subregion(s) you want 
graphed. When you make a selection, all measurements in the selected subregions are 
place din the table to the right. It is similar to the table in the Review tab, but the Date 
and ID columns have been removed and replaced with columns for each of the 6 tests.

You can select multiple subregions to put in the table. As you casn see, there are 
checkboxes next to each item in the table. These checkboxes denote whether the item 
is displayed in the graph below. Checking and unchecking these boxes will add and 
remove the item from the graph. Just above the top left corner of the graph, below 
the Range of Motion list, is a button labeled ‘Create Summary Report’. Clicking on the 
button will create a report using the data that is currently being graphed.
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History Graph

The history graph is used to display the data over a series of sessions taken over time. 
The data that is used here is taken directly from the table in the Review Tab. It is best to
have movements from multiple sessions in order for the graph to be effective. You 
may graph multiple different movements (e.g. flexion and extension) or you can just 
graph a single movement. If there is only one movement being graphed, a line for the 
norm of that movement will be displayed as well. The points that are displayed for each 
movement are the average for that session. Just above the top left corner of the graph is 
a button labeled ‘Create History Report’. Clicking on the button will create a report using 
the data that is currently being graphed.

Reports
Acumar DataCapture™ makes it easy to generate reports based on captured data. There 
are two kinds of reports that can be generated: Summary reports and History reports. 
The summary report takes data from a single session and displays a table and graph of 
each of the movement’s data.
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The history graph requires data from multiple sessions. Each movement has a separate 
table that lists the measurements for that movement in chronological order. Below each 
of these tables is a graph of the movements over time, compared against the norm for 
the movement.
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Generating Reports
To generate a report, click on the Generate a Report button in the home window, or you 
may go to File -> Generate Report in the tool bar. A dialog window should appear.

At the top are radio buttons that set whether the report you will generate is a Session 
Summary or a History report. Below those is the First and End Session drop downs. If 
Session Summary is checked, then only the First Session drop down is enabled. The 
session selected there will be the session chosen for the summary report.

If History is checked, then, once a selection is made in First Session, End Session will be 
enabled and contain the Sessions that are chronologically after the session selected in 
First Session. Example: If a Session on 8/22/2011 is selected in First Session, then only 
sessions dated after August 22, 2011 will be displayed in End Session.
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On the right half of 
the window is a tree 
that contains all of the 
Regions, Subregions 
and Movements in a 
Session. Each of these 
has a check box next to 
it. Movements that are 
checked will be displayed 
in the report from the 
session(s) selected via the 
drop downs. If a Region 
or Subregion is checked, 
then all Subregions or 
Movements it contains 
will also be checked. If 
it is unchecked, then 
only some or no child 
subregions or movements 
are checked.

Creating Reports from Review
You may also generate reports from the review page. To generate a Session Summary 
report, select the session you want to report and then go to either the Summary or 
Range of Motion tabs. Select the specific data that you want to report. Before clicking 
the Create Summary Report button above the graph, make sure that any movements 
you want to report are currently in the graph. Only data that is currently being graphed 
will be used in the report.

Creating a history report is similar to creating the summary report. Select the sessions 
and movement(s) you want to graph and click on the History tab. If all the data you want 
to graph is currently displayed, then just click the Create History Report button and it 
will be automatically created. As the summary graph, only data that is currently being 
graphed will be used to create the report.
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Terms and Conditions
LIC Worldwide Headquarters
Toll-Free: (800) 428-7545 (USA only)
Phone: (765) 423-1505
Fax: (765) 423-4111
Email:    sales@lafayetteinstrument.com
 export@lafayetteinstrument.com (Outside the USA)  

Mailing Address: 
Lafayette Instrument Company 
PO Box 5729 
Lafayette, IN 47903, USA 

Lafayette Instrument Europe: 
Phone: +44 1509 817700
Fax:     +44 1509 817701
Email:  eusales@lafayetteinstrument.com

Phone, Fax, Email or Mail-in Orders
All orders need to be accompanied by a hard copy of your purchase order. All 
orders must include the following information:

•	 Quantity 
•	 Part Number 
•	 Description 
•	 Your purchase order number or method of pre-payment
•	 Your tax status (include tax-exempt numbers) 
•	 Shipping address for this order 
•	 Billing address for the invoice we’ll mail when this order is shipped 
•	 Signature and typed name of person authorized to order these 

products 
•	 Your telephone number 
•	 Your email address 
•	 Your FAX number 

Domestic Terms
There is a $50 minimum order. Open accounts can be extended to most 
recognized businesses. Net amount due 30 days from the date of shipment 
unless otherwise specified by us. Enclose payment with the order; charge with 
VISA, MasterCard, American Express, or pay COD. We must have a hard copy 
of your purchase order by mail, E-mail or fax. Students, individuals and private 
companies may call for a credit application.

International Payment Information
There is a $50 minimum order. Payment must be made in advance by: draft 
drawn on a major US bank; wire transfers to our account; charge with VISA, 
MasterCard, American Express, or confirmed irrevocable letter of credit. 
Proforma invoices will be provided upon request.

Exports
If ordering instrumentation for use outside the USA, please specify the country 
of ultimate destination, as well as the power requirements (110V/60Hz or 
220V/50Hz). Some model numbers for 220V/50Hz will have a “*C” suffix.

Quotations
Quotations are supplied upon request. Written quotations will include the price 
of goods, cost of shipping and handling, if requested, and estimated delivery 
time frame. Quotations are good for 30 days, unless otherwise noted.  Following 
that time, prices are subject to change and will be re-quoted at your request.

Cancellations
Orders for custom products, custom assemblies or instruments built to customer 
specifications will be subject to a cancellation penalty of 100%. Payment for up 
to 100% of the invoice value of custom products may be required in advance. 
Cancellation for a standard Lafayette Instrument manufactured product once 
the product has been shipped will normally be assessed a charge of 25% of the 
invoice value, plus shipping charges.  Resell items, like custom products, will be 
subject to a cancellation penalty of 100%.

Exchanges and Refunds
Please see the cancellation penalty as described above. No item may be returned 
without prior authorization of Lafayette Instrument Company and a Return 
Goods Authorization (RGA#) number which must be affixed to the shipping 
label of the returned goods.  The merchandise should be packed well, insured 
for the full value and returned along with a cover letter explaining the reason for 
return. Unopened merchandise may be returned prepaid within thirty (30) days 
after receipt of the item and in the original shipping carton. Collect shipments 
will not be accepted. Product must be returned in saleable condition, and credit 
is subject to inspection of the merchandise. 

Repairs
Instrumentation may not be returned without first receiving a Return Goods 
Authorization Number (RGA). When returning instrumentation for service, 

please call Lafayette Instrument to receive a RGA number. Your RGA number 
will be good for 30 days. Address the shipment to:
Lafayette Instrument Company
3700 Sagamore Parkway North
Lafayette, IN 47904, USA.

Shipments cannot be received at the PO Box. The items should be packed 
well, insured for full value, and returned along with a cover letter explaining 
the malfunction. An estimate of repair will be given prior to completion 
ONLY if requested in your enclosed cover letter. We must have a hard copy 
of your purchase order by mail or fax, or repair work cannot commence for 
non-warranty repairs.

Damaged Goods
Damaged instrumentation should not be returned to Lafayette Instrument 
prior to a thorough inspection. If a shipment arrives damaged, note damage on 
delivery bill and have the driver sign it to acknowledge the damage. Contact the 
delivery service, and they will file an insurance claim. If damage is not detected at 
the time of delivery, contact the carrier/shipper and request an inspection within 
10 days of the original delivery. Please call the Lafayette Instrument Customer 
Service Department for repair or replacement of the damaged merchandise.

Limited Warranty
Lafayette Instrument Company warrants equipment manufactured by the 
company to be free of defects in material and workmanship for a period of one 
year from the date of shipment, except as provided hereinafter. The original 
manufacturer’s warranty will be honored by Lafayette Instrument for items not 
manufactured by Lafayette Instrument Company, i.e. resell items.  This assumes 
normal usage under commonly accepted operating parameters and excludes 
consumable products.

Warranty period for repairs or used instrumentation purchased from Lafayette 
Instrument is 90 days.  Lafayette Instrument Company agrees either to 
repair or replace, at its sole option and free of part charges to the customer, 
instrumentation which, under proper and normal conditions of use, proves to 
be defective within the warranty period.  Warranty for any parts of such repaired 
or replaced instrumentation shall be covered under the same limited warranty 
and shall have a warranty period of 90 days from the date of shipment or the 
remainder of the original warranty period whichever is greater. This warranty 
and remedy are given expressly and in lieu of all other warranties, expressed or 
implied, of merchantability or fitness for a particular purpose and constitutes 
the only warranty made by Lafayette Instrument Company.  
  
Lafayette Instrument Company neither assumes nor authorizes any person to 
assume for it any other liability in connection with the sale, installation, service or 
use of its instrumentation. Lafayette Instrument Company shall have no liability 
whatsoever for special, consequential, or punitive damages of any kind from any 
cause arising out of the sale, installation, service or use of its instrumentation. 
All products manufactured by Lafayette Instrument Company are tested and 
inspected prior to shipment. Upon prompt notification by the Customer, 
Lafayette Instrument Company will correct any defect in warranted equipment 
of its manufacture either, at its option, by return of the item to the factory, or 
shipment of a repaired or replacement part. Lafayette Instrument Company 
will not be obliged, however, to replace or repair any piece of equipment, 
which has been abused, improperly installed, altered, damaged, or repaired by 
others. Defects in equipment do not include decomposition, wear, or damage by 
chemical action or corrosion, or damage incurred during shipment.

Limited Obligations Covered by this Warranty
1.	 In the case of instruments not of Lafayette Instrument Company 

manufacture, the original manufacturer’s warranty applies.
2.	 Shipping charges under warranty are covered only in one direction. The 

customer is responsible for shipping charges to the factory if return of 
the part is required.

3.	 This warranty does not cover damage to components due to improper 
installation by the customer. 

4.	 Consumable and or expendable items, including but not limited to 
electrodes, lights, batteries, fuses, O-rings, gaskets, and tubing, are 
excluded from warranty.

7.	 Failure by the customer to perform normal and reasonable maintenance 
on instruments will void warranty claims.

8.	 If the original invoice for the instrument is issued to a company that 
is not the company of the end user, and not an authorized Lafayette 
Instrument Company distributor, then all requests for warranty must 
be processed through the company that sold the product to the end 
user, and not directly to Lafayette Instrument Company.

Export License
The U.S. Department of Commerce requires an export license for any polygraph 
system shipment with an ULTIMATE destination other than: Australia, Japan, 
New Zealand or any NATO Member Countries. It is against U.S. law to ship a 
Polygraph system to any other country without an export license. If the ultimate 
destination is not one of the above listed countries, contact us for the required 
license application forms.


